
For Health Systems Using Oracle Cerner

CV RISK MANAGEMENT:
USING EHR FEATURES TO IDENTIFY,  
EVALUATE, AND ENGAGE PATIENTS

For Patients With Very High Risk (VHR) Atherosclerotic Cardiovascular 
Disease (ASCVD), Who Have Had a Recent Myocardial Infarction (MI)

IDENTIFY
Use clinical criteria to 

generate Patient Reports of 
patients with VHR ASCVD

EVALUATE
Use Discern Alerts or Health 

Maintenance Recommendations to 
alert providers to consider treatment 

for patients with VHR ASCVD 
including a recent MI

ENGAGE
Use Patient and Primary Care 
Provider Communications to 
encourage patients to make 

appointments and engage in care

EHR=Electronic Health Record.



2

Table of Contents

About This Guide...................................................................................................................................... 3

CV Risk Management Unmet Need........................................................................................................ 4

Using EHRs to Identify, Evaluate, and Engage Patients...................................................................... 8

  Identify: Using Patient Reports.................................................................................................... 10

  Evaluate: Role of Discern Alerts and Health Maintenance Recommendations...................... 12

  Engage: Using Patient and Primary Care Provider Communications...................................... 15

Appendix A: Glossary of Terms............................................................................................................ 19

Appendix B: Dynamic Worklist............................................................................................................. 20

Appendix C: Discern Analytics............................................................................................................. 21

Appendix D: Discern Alerts................................................................................................................... 26

Appendix E: Health Maintenance Recommendations....................................................................... 32

Appendix F: Patient Communications................................................................................................. 38

Appendix G: Primary Care Provider Communications....................................................................... 41



3

A
B

O
U

T
  

T
H

IS
 G

U
ID

E
U

N
M

E
T

  
N

E
E

D
U

S
IN

G
 T

H
E

  
E

H
R

 
ID

E
N

T
IF

Y
E

VA
LU

A
T

E
E

N
G

A
G

E
A

P
P

E
N

D
IC

E
S

About This Guide
Amgen has developed this EHR guide for educational purposes only, to assist health systems in configuring their 
Oracle Cerner capabilities to help identify very high risk atherosclerotic cardiovascular disease (VHR ASCVD) 
patients who have had a myocardial infarction (MI). Amgen does not endorse specific EHR systems.

This guide provides insights and examples to help clinical decision makers implement automated EHR 
functionalities that can prompt follow-up for VHR ASCVD patients who have had an MI. It does not constitute 
guidance for medical advice or treatment.

The information listed in this guide is based upon the most recent version of Oracle Cerner at the time 
of publication. 

Note:

•	 Functions and features may change as new software versions are released

•	 This guide is meant to serve as summary information only and should not replace detailed instructions 
provided to you by your internal or external EHR support resources

•	 Screen images shown within represent hypothetical screens in Oracle Cerner

•	 Amgen makes no claims or warranties about the applicability or appropriateness of this information

See Appendix A for a Glossary of Terms for Oracle Cerner.
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*�A retrospective cohort study of adults using data from the MarketScan database (Truven Health Analytics, IBM Watson Health). 
Analysis was restricted to patients with a history of major ASCVD on December 31, 2015, defined according to the 2018 ACC/AHA 
cholesterol guideline as a recent acute coronary syndrome, history of MI other than recent ACS, or history of ischemic stroke or 
symptomatic PAD. Patients were followed for their first ASCVD event including MI, ischemic stroke, or major adverse limb events 
with censoring occurring upon loss of health insurance benefits on December 31, 2017.2

Millions of Americans Are Estimated to Have VHR ASCVD1

2018 American Heart Association (AHA)/American College of Cardiology (ACC)/
Multisociety Definitions of VHR ASCVD3

History of Multiple  
Major ASCVD Events

A Major ASCVD Event and Multiple  
High-Risk Conditions

Major events include:

•	 Recent acute coronary 
syndrome (ACS), within  
the past 12 months

•	 History of myocardial 
infarction (MI), other than a 
recent ACS

•	 History of ischemic stroke

•	 Symptomatic peripheral 
arterial disease (PAD)

Conditions include:

•	 Age ≥ 65 years

•	 Heterozygous familial hypercholesterolemia

•	 History of prior coronary artery bypass surgery or percutaneous 
coronary intervention outside of the major ASCVD event(s)

•	 Diabetes mellitus

•	 Hypertension

•	 Chronic kidney disease (eGFR 15-59 mL/min/1.73 m2)

•	 Current smoking

•	 Persistently elevated low-density lipoprotein cholesterol (LDL-C) 
≥ 100 mg/dL (≥ 2.6 mmol/L) despite maximally tolerated statin 
therapy and ezetimibe

•	 History of congestive heart failure 

Note: Please refer to the related EHR Worksheet Resource 
for potential codes, inclusion and exclusion criteria for 
your consideration.

OR

US Adults With a History of Major  
ASCVD Events that Meet the VHR Criteria:2,*

History of 
Any Major 
ASCVD Event

History of MI

VHR

History of Any Major
ASCVD Event

History of MI

94.0% %96.5
VHRVHR

History of Any Major
ASCVD Event

History of MI

94.0% %96.5
VHR
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The ASCVD event rate was 3 times higher among those who met the 
definition of VHR in the 2018 AHA/ACC/Multisociety guideline than for 
those who did not meet this definition.4,*

Patients With VHR ASCVD Are at Higher Risk for Recurrent CV 
Events Compared to ASCVD Patients Without VHR4

Among Patients With VHR ASCVD, Those With Multiple Major  
ASCVD Events Had the Highest Risk of Further ASCVD Events4,*

*�Analysis of 27,775 US adults with a history of ASCVD from the MarketScan database (Truven Health Analytics, IBM Watson 
Health). A history of ASCVD was defined as a history of myocardial infarction (MI), stable angina, unstable angina; previous 
coronary artery bypass grafting (CABG) or percutaneous coronary intervention (PCI); ischemic stroke, transient ischemic attack, 
carotid endarterectomy, carotid, vertebral, or basilar stenting; peripheral artery disease (PAD); artery aneurysm, or endovascular 
stent graft placement. All available claims prior to January 1, 2016, were used to define very high ASCVD risk. Consistent with 
the 2018 AHA/ACC/Multisociety guideline, a very high ASCVD risk was defined as a history of multiple major ASCVD events or 1 
major ASCVD event in addition to multiple high-risk conditions.4
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The 2022 ACC Expert Consensus Decision Pathway 
Recommends Reducing CV Risk by Optimizing LDL-C 
Management in VHR ASCVD Patients5 

•	 Per recommendations, consider addition of nonstatins to maximally-tolerated statin therapy for VHR ASCVD 
patients with an LDL-C level above the threshold of LDL-C ≥ 55 mg/dL or less than 50% LDL-C reduction5,*

Though the Relationship Between LDL-C Reduction and CV 
Risk Management Is Clear, Few Patients With ASCVD Receive 
Adequate Treatment6-7

*�Note that this process did not involve formal systematic reviews, grading of evidence, or synthesis of evidence. The goal was to provide practical guidance 
in situations not covered by the 2018 AHA/ACC/Multisociety guideline until the next round of guidelines has the opportunity to formally review recent 
scientific evidence.

†�Study conducted using de-identified Health Insurance Portability and Accountability Act-compliant administrative healthcare claims from facilities, providers, 
and outpatient pharmacies from the Truven MarketScan Research Database, which contains healthcare data for more than 43.6 million covered lives. Enrollees 
who met all of the following criteria were included in the analytic cohort: ≥ 1 valid LDL-C measurement in 2014 (date of last measurement defined as index 
date), age ≥ 21 years as of the index date, continuous enrollment in the database for ≥ 5 years prior to the index date, a diagnosis of ASCVD or diabetes, or 
likely heterozygous familial hypercholesterolemia during the baseline period. Demographic and clinical characteristics, including comorbidities and risk factors 
of interest, were assessed for each disease group, along with treatment status and LDL-C. The extrapolated prevalence of ASCVD was 18.3 million (8.0% of the 
adult population), of which a total of 32.8% of patients with ASCVD were considered to be at very high risk according to the 2018 
Guideline. A patient was assumed to be taking a medication at index if (a) the pharmacy claim date preceded the index date and 
the runout date was the index date or later, or (b) the pharmacy claim runout date was no later than 30 days prior to the index 
date. Patients who had either no pharmacy claim or had a pharmacy claim with a runout date earlier than 30 days before index 
were not considered to be on the medication.1

of patients with VHR ASCVD on statin therapy and/
or ezetimibe had LDL-C < 55 mg/dL65% 18% 35%

In an analysis of patient-level data in the Truven MarketScan Research Database:1,†

65% 18% 35%
were receiving  
a high-intensity  
statin

65% 18% 35%

Among those with VHR ASCVD, at the time of the LDL-C assessment index date:1,†

weren’t receiving 
any statin  
or ezetimibe
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“The low proportion of patients with a history of major ASCVD events 
taking a high-intensity statin and ezetimibe indicates a need for 
strategies to increase the initiation of, and adherence to, intensive 
lipid-lowering therapies...”

– Muntner P et al., Cardiovasc Drugs Ther 20212

New Strategies May Be Needed to Lower Cardiovascular Risk 
for Patients With VHR ASCVD
Quality Measures Have Not Kept up With Guidelines and Recommendations 
for ASCVD Risk

Though clinical guidelines outline LDL-C 
management criteria to mitigate ASCVD risk, 
LDL-C levels are not prioritized by current 
healthcare quality performance measures2

Instead, quality performance measures 
typically focus on activities (eg, statin 
prescribing) and short-term outcomes  
(eg, 30-day readmissions) and not longer-
term outcomes8-10
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“...the EHR has the potential to automatically identify patients...(of) 
whom physicians might not otherwise be aware.”

- Roumia M and Steinhubl S, Curr Cardiol Rep 201412

EHR Capabilities Can Help Identify 
Undertreated ASCVD Patients for Follow-Up 
Evaluation and Engagement11

•	 Population health programs using EHRs can help to successfully identify very high-risk ASCVD patients 
and significantly improve guideline and recommended LDL-C control11

•	 Given the importance of risk reduction for VHR ASCVD patients who have had an MI, identification of these 
patients is key13

EHR Patient Reports, Discern Alerts, Health Maintenance 
Recommendations, Automated Patient Communications, and 
Primary Care Provider Communications May Be Implemented 
to Help Improve Care for Patients With VHR ASCVD

IDENTIFY
Use clinical criteria to generate 

Patient Reports of patients 
potentially eligible for CV 

disease management

EVALUATE
Use Discern Alerts or 
Health Maintenance 

Recommendations to alert 
providers to consider treatment 
for VHR ASCVD patients who 

have had an MI

ENGAGE
Use Patient and Primary Care 
Provider Communications to 
encourage patients to make 
appointments and engage 

in care
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Actions for a Clinical Champion as Part of the Effort to Help 
VHR ASCVD Patients Prevent Recurrent CV Events

IDENTIFY

Submit EHR 
Support Request: 

Patient Report

EVALUATE

Submit EHR 
Support Request: 

Discern Alert or Health 
Maintenance 

Recommendations

ENGAGE

Submit EHR 
Support Request: 

Patient and Primary 
Care Provider 

Communications

Review Patient Report: 
Refine Criteria if 

Needed
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Role of Patient Reports in 
Identifying ASCVD Patients 

Patient Reports can be used to identify patients with VHR ASCVD 
after they experience an MI. Once programmed, Patient Reports can 
be used by organizations to understand which of their patients may 
benefit from follow-up. Oracle also has reporting features called 
Dynamic Worklist and Discern Analytics that enable reports with 
clinical criteria. You can find step-by-step instructions to run a 
Patient Report with Oracle Cerner’s Dynamic Worklist functionality 
in Appendix B of this document. Instructions for using Discern 
Analytics can be found in Appendix C of this document.

To run a Patient Report, the EHR relies on clinical criteria inputs. These criteria filter the database of patients 
to display only those you wish to include on the Patient Report.

For example, the criteria in the table below may be used to identify patients with VHR ASCVD.5 These criteria 
are listed as examples only. Health systems should independently choose the clinical criteria they deem 
appropriate to generate the Patient Reports.

Note: Both Dynamic Worklist and Discern Analytics features require appropriate permissions for access.

*�Codes are intended to guide provider efforts to identify patients potentially eligible for cardiovascular risk management. 
They are provided for reference purpose only and may not be all-inclusive. The responsibility to determine coverage and 
reimbursement parameters, and appropriate coding for a particular patient and/or procedure, is always the responsibility 
of the provider or physician.

Example clinical criteria for patients with VHR ASCVD who may benefit from the addition of nonstatin therapy3,5

Major ASCVD Event ICD-10 Diagnosis Code* Timing

Myocardial infarction (MI) I21 Any 

Acute coronary syndrome (ACS) I24.0 Within last 12 months

High-risk condition ICD-10 Diagnosis Code* Timing

Diabetes E10 or E11 Current

Hypertension I10 Current

Laboratory tests Value Timing

LDL-C

LDL-C ≥  55 mg/dL Past 90 days

OR

Missing fasting or non-fasting lipid panel Past 12 months

Medications Type/dose Timing

Lipid-lowering therapy
High-intensity statin (atorvastatin 40 mg to 80 mg or 
rosuvastatin 20 mg to 40 mg) ± ezetimibe 

At least 1 month

Interventions Procedure Code* Timing

Percutaneous coronary intervention 92920 Any

IDENTIFY

Submit EHR 
Support Request: 

Patient Report

EVALUATE

Submit EHR 
Support Request: 

Discern Alert or Health 
Maintenance 

Recommendations

ENGAGE

Submit EHR 
Support Request: 

Patient and Primary 
Care Provider 

Communications

Review Patient Report: 
Refine Criteria if 

Needed
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For the Healthcare Provider

Requesting Patient Reports From the EHR Support Team

Requesting healthcare providers must provide key information 
for Patient Reports before the setup can be managed by the 
EHR support team as part of a typical process for requesting, 
approving, and implementing EHR changes.

The healthcare provider may then update the criteria to refine the results.

�
  Inclusion and Exclusion Criteria for Patient Reports

Note: Please refer to the related EHR Worksheet Resource for potential inclusion and exclusion criteria for 
your consideration. 

Instructions for running a Patient Report in Dynamic Worklist can be found in Appendix B in this document. 
Instructions for using Discern Analytics can be found in Appendix C.

  
For the EHR Support Team

In Oracle, a list of patients can be created using Discern Analytics, and saved to a folder for on-demand running 
or scheduling. Dynamic Worklist can be created and run by the user on demand and as needed. Once the Patient 
Report is implemented, healthcare providers can run the report and assess the results.

IDENTIFY

Submit EHR 
Support Request: 

Patient Report

EVALUATE

Submit EHR 
Support Request: 

Discern Alert or Health 
Maintenance 

Recommendations

ENGAGE

Submit EHR 
Support Request: 

Patient and Primary 
Care Provider 

Communications

Review Patient Report: 
Refine Criteria if 

Needed

Requesting and Implementing 
Patient Reports

Age
Sex
Language
Race
Associated Providers
Care Coordinator
Financial Class
Health Plan Type
Readmission Risk
Admission Range
Discharge Range
Encounter Type
Case Status
Appointment Status
Conditions
Laboratory
Vital Signs
Measurements
Risk Stratification
Medicaitons
Order Status
Health Maintenance
Registry
Communication Preference
Ranking
Qualifying Status
Pending Work

Viewing 5573 Total Patients
    2788 No longer meet search criteria

Patient Primary Care Provider

TEST, JOHN 1
DOB: 06/10/1952 (67 years)
Sex: Male
MRN: 

Filters

List Actions Add PatientDetails

Clear AllApply

Dynamic Worklist

Remove Patient Generate Communication Help

Conditions

Diabetes
Hyperlipidemia

Payer/Health Plan/Class

HEALTHE/Commercial/Comm...
HEALTHE/Commercial/Comm...

1 Inpatient/180 days
1 Outpatient/180 days

Risk Visits/Timeframe

TEST, JANE 1
DOB: 07/08/1978 (41 years)
Sex: Female
MRN: 

Cigna/Commercial/Commerci... 5 Outpatient/180 days

TEST, JOHN 2
DOB: 06/01/2008 (11 years)
Sex: Male
MRN: 

Hyperlipidemia
Hypertension
Diabetes

HEALTHE/Commercial/Comm... 1 Inpatient/180 days
3 Outpatient/180 days

TEST, JANE 2
DOB: 01/01/1940 (80 years)
Sex: Female
MRN: 

Asthma
Diabetes
Hypertension
Hyperlipidemia

Aetna PPO/Commercial/Comm... 1 Inpatient/180 days
2 Outpatient/180 days
1 ED Visit/180 days

TEST, JOHN 3
DOB: 03/05/2006 (14 years)
Sex: Male
MRN: 

Blue Cross PPO/Commercial/...
Blue Cross PPO/Commercial/...

2 Inpatient/180 days
5 Outpatient/180 days

TEST, JOHN 4
DOB: 10/10/1950 (69 years)
Sex: Male
MRN: 

Hyperlipidemia
Diabetes
Hypertension

Medicare/Medicare/Medicare

Example of a Dynamic Worklist.
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Role of Discern Alerts 
and Health Maintenance 
Recommendations

Discern Alerts are automated alerts displayed at the point of care 
that remind or flag providers to evaluate treatment when a patient 
meets specific criteria. For example, a BPA may be configured 
to notify providers if a patient meets the 2018 AHA/ACC/
Multisociety criteria for VHR ASCVD2 and also may benefit from 
the recommendations in the 2022 ACC Consensus Pathway.5 
Similarly, Health Maintenance Recommendations may be used 
in the EHR to remind patients and staff about completed and 
upcoming preventive health tests and procedures.

Because they are tied to clinical criteria, Discern Alerts are designed to prompt relevant actions. When 
patients meet set criteria that identifies them as possibly having VHR ASCVD, the EHR can suggest certain 
actions, such as medication review, ordering follow-up tests, or creating a referral for the patient. These 
actions are typically based on best practice care guidelines and are developed in partnership with clinical 
leadership at the institution.

You can find instructions to create a Discern Alert in Appendix D of this document. Instructions for setting up 
Health Maintenance Recommendations can be found in Appendix E.

Using SmartZone for Non-Critical Alerts and Referential Patient Information
SmartZone is a passive alerting window that displays non-critical alerts and reminders with less disruption to 
the workflow. Using a SmartZone to display Discern Alerts in an unobtrusive, yet visible and meaningful way, 
may help reduce the alert fatigue that results from too many alerts appearing when the patient’s chart is opened. 

SmartZone can be used to 
display alerts that do not require 
immediate action along with 
patient-specific referential 
information. SmartZone should 
not be used for critical or time-
sensitive alerts, messages 
requiring immediate action, or 
alerts that will be triggered based 
on an action taken while the 
patient’s chart is open.

IDENTIFY

Submit EHR 
Support Request: 

Patient Report

EVALUATE

Submit EHR 
Support Request: 

Discern Alert or Health 
Maintenance 

Recommendations

ENGAGE

Submit EHR 
Support Request: 

Patient and Primary 
Care Provider 

Communications

Review Patient Report: 
Refine Criteria if 

Needed

Full screen Print 0 minutes ago

Alerts

Example of ALERT that
links to Results Review

Information

Example of INFORMATION
that launches a form

Warning

Example of WARNING
that launches a URL

Example of SmartZone and Icons.
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Example of a 
Discern Alert.

Example of a Health 
Maintenance Recommendation.

Add Recommendation

Selected

VHR ASCVD At Risk
      Select All (1)

VHR ASCVD At Risk - VRH ASCVD

Reason and Comments

Recurrence

Reason

Recorded for
If no user is selected, the current user will be saved

Next Due

12 months

Select

Comments

Enter comment here

Smith MD, Douglas

Date 12/16/2023

Delete Entry

CancelSubmit (1)

Discern Alert - Test, Patient

This ASCVD patient may be at high risk for a future ASCVD event.

OK

This patient may be at very high risk for future ASCVD Event, according to the 
2018 AHA/ACC/Multisociety Guideline.

Order medication
Refer to cardiologist

Alert Action
Open a lipid-lowering therapy order set
Order a lipid-panel test

Risk Factor for Future ASCVD 
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For the Healthcare Provider

Requesting healthcare providers or others in the health system may 
wish to request Reminders to help ensure follow-up for patients 
identified on the Patient Reports. Below are some examples of how 
you may decide to set up your Discern Alerts.

�
  Inclusion and Exclusion Criteria for Reminders

Please refer to the related EHR Worksheet Resource for potential inclusion and exclusion criteria for 
your consideration.

For Discern Alerts Only:
To effectively communicate with EHR support staff when requesting an Alert provide specific details, 
for example:

Evoke: The action(s) which occur within the EHR that initiate the rule logic, such as upon chart open by users 
in a particular role 

Logic: The rule criteria to be used in evaluating the data

Actions: Displays the options available to the user, for example:

•	 Open a lipid-lowering therapy order set

•	 Order a lipid-panel test

•	 Refer to a cardiologist or lipid clinic 

IDENTIFY

Submit EHR 
Support Request: 

Patient Report

EVALUATE

Submit EHR 
Support Request: 

Discern Alert or Health 
Maintenance 

Recommendations

ENGAGE

Submit EHR 
Support Request: 

Patient and Primary 
Care Provider 

Communications

Review Patient Report: 
Refine Criteria if 

Needed

Requesting and 
Implementing Reminders 
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Role of Patient 
Communications

Healthcare providers, or others in the health system, may request 
Patient Communications to communicate with patients identified 
on the Patient Reports. Patient Communications are letters sent 
either electronically via the HealtheLife® patient portal or by mail 
to all patients who meet the criteria specified in the EHR. Patient 
Communications can be used as the basis to proactively contact 
VHR ASCVD patients who have experienced an MI. 

Communications to patients can indicate the reason for follow-up 
along with a call-to-action, such as to schedule an appointment 
for evaluation. They can also include supporting educational materials prior to the visit, such as information on 
ASCVD risk and available treatment options. These communications are then recorded in the patient’s chart 
for reference. You can find step-by-step instructions for creating Patient Communications in Appendix F.

IDENTIFY

Submit EHR 
Support Request: 

Patient Report

EVALUATE

Submit EHR 
Support Request: 

Discern Alert or Health 
Maintenance 

Recommendations

ENGAGE

Submit EHR 
Support Request: 

Patient and Primary 
Care Provider 

Communications

Review Patient Report: 
Refine Criteria if 

Needed

Example of patients qualifying for recommendation outreach.

Schedule

Program: Display:

Status Export View History Find  CustomizeGenerate CommunicationsView Documents

ASCVD Risk Patient Health Maintenance Recommendation Patients

Patients

Consumer Name
Mary Smith
Donna Jones
Jane Washington
Thelma Lincoln
Flo Truman
Elizabeth Robinson

4/6/1949
3/28/1967
4/23/1969
6/18/1955
6/18/1955
5/12/1959

Qualified for Invitation
Qualified for Invitation
Qualified for Invitation
Qualified for Invitation
Qualified for Invitation
Qualified for Invitation

DOB Tracking Status Recommendation Status
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For the Healthcare Provider

Suggested Request to the EHR Support Team: 

Patient Communications

Similar to the other EHR capabilities, healthcare providers must 
provide key information for Patient Communications before the 
setup can be managed by the EHR support team.

 Inclusion and Exclusion Criteria for Patient Communications

 Message Configuration
•	 Subject

Example language:

Hi [[Patient Name]]:

Know your numbers—it’s important that your LDL-C is < 55 mg/dL to help manage your risk level. 
Preventive medicine plays an important part in your health and overall well-being. Given the risk factors 
and your history of cardiovascular events, you may be at an elevated risk for another event. It’s important to 
schedule an appointment for follow-up evaluation and to discuss your heart health with your physician.

To schedule your appointment, contact your cardiologist or connect via HealtheLife patient portal.

Sincerely,

[[Organization Name]]

Note: Please refer to the related EHR Worksheet Resource for potential inclusion and exclusion criteria for 
your consideration.

IDENTIFY

Submit EHR 
Support Request: 

Patient Report

EVALUATE

Submit EHR 
Support Request: 

Discern Alert or Health 
Maintenance 

Recommendations

ENGAGE

Submit EHR 
Support Request: 

Patient and Primary 
Care Provider 

Communications

Review Patient Report: 
Refine Criteria if 

Needed

Requesting and Implementing  
Patient Communications

•	 Message body (required field) •	 Reply options •	 Attachment options
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Primary Care Provider (PCP) 
Communications

Role of PCP Communications
PCP Communications are used to engage and advise the 
identified patient’s Primary Care Provider. For PCPs within 
the health system, the message can be sent as an Automated 
Message Center Message. To reach PCPs outside of the health 
system, messages can be sent electronically as a Direct Message 
or fax. Much like a referral letter, these communications can be 
recorded in the patient chart.

PCP Communications can be used to proactively reach out to the identified patient’s PCP as part of an 
organization’s cardiovascular EHR improvement effort. The communication can indicate the reason for follow-
up along with a call-to-action, such as to schedule an appointment or to keep providers apprised of changes 
to the patient’s treatment plan. A rule can be defined based on criteria to automatically generate and send a 
message to the patient’s PCP.

IDENTIFY

Submit EHR 
Support Request: 

Patient Report

EVALUATE

Submit EHR 
Support Request: 

Discern Alert or Health 
Maintenance 

Recommendations

ENGAGE

Submit EHR 
Support Request: 

Patient and Primary 
Care Provider 

Communications

Review Patient Report: 
Refine Criteria if 

Needed

For the Healthcare Provider

Suggested Request to the EHR Support Team: Primary Care Provider Communications

Similar to the other EHR capabilities, healthcare providers must provide key information for Primary Care 
Communications before the setup can be managed by the EHR support team.

  
For the EHR Support Team

Refer to Appendix G for detailed instructions.

DocumentsInbox Summary

Message Center

CommunicateInbox

Last 90 Days ...

Inbox Items (1)

Messages (0/2)
General Messages (0/2)

Display:

Proxies Pools Open Message Journal Sign All Review All Forward Only Select All

Assigned

Heavin, 03 - A... Pending

Status

ZZTEST, CARE

Patient Name

US Abdomen - RAD: US Abdomen, 2.16.2023

Description - Subject

Recent

Full screen Print 0 minutes ago

Name

Documents (1/1)
Sign (1/1)

Results

Example PCP receiving Message Center Message.
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Primary Care Provider (PCP) 
Communications (cont’d)

Requesting and Implementing Primary Care 
Provider Communications
Clinical decision makers may consider providing the following 
information to their EHR support team for their use in configuring 
PCP Communications:

•	 Patients to include

•	 Methods of communication

•	 When to send and appropriate qualifier, for example, XX days after change in lipid-lowering therapy

•	 Message to Primary Care Provider, for example,

[[PCP Name]]:

Regarding: [[Patient Name]], [[DOB: DOB]]

We saw your patient on XX/XX/XXXX and initiated a change in lipid-lowering therapy. This change was 
based on your patient’s LDL-C levels on recent laboratory tests. For your review, we have attached 
pertinent information regarding their care at this facility.

Sincerely,

[[Facility contact information]]

•	 Attachments, for example, procedure notes or lab results

IDENTIFY

Submit EHR 
Support Request: 

Patient Report

EVALUATE

Submit EHR 
Support Request: BPA 
or Health Maintenance 

Reminders

EVALUATE

Submit EHR 
Support Request: BPA 
or Health Maintenance 

Reminders

ENGAGE

Submit EHR 
Support Request: 

Patient Follow-Ups and 
Primary Care Provider 

Communications

EVALUATE

Submit EHR 
Support Request: BPA 
or Health Maintenance 

Reminders

EVALUATE

Submit EHR 
Support Request: BPA 
or Health Maintenance 

Reminders

ENGAGE

Submit EHR 
Support Request: 

Patient Follow-Ups and 
Primary Care Provider 

Communications

Review Patient Report: 
Refine Criteria if 

Needed

ENGAGE

Submit EHR 
Support Request: 

Patient Follow-Ups and 
Primary Care Provider 

Communications

IDENTIFY

Submit EHR 
Support Request: 

Patient Report

Review Patient Report: 
Refine Criteria if 

Needed

ENGAGE

Submit EHR 
Support Request: 

Patient Follow-Ups and 
Primary Care Provider 

Communications

IDENTIFY

Submit EHR 
Support Request: 

Patient Report

Review Patient Report: 
Refine Criteria if 

Needed

IDENTIFY

Submit EHR 
Support Request: 

Patient Report

Review Patient Report: 
Refine Criteria if 

Needed
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Appendix A: Glossary of Terms

EHR Term Definition

Care Guidelines The clinical treatment guidelines by which the practice or health system have agreed 
are best practices to follow. The guidelines are the basis of Discern Alerts and other 
reminders in the EHR.

Clinical Champion The person within the practice who is the “go-to” for EHR-related questions. Sometimes 
this person is also responsible for setup of the EHR.

Discern Alerts A Cerner-specific term for reminders that display in the EHR for the HCP, based upon the 
patient meeting certain criteria. 

Discern Analytics Cerner’s Analytics/Reporting tool. Primarily used by EHR support team. Uses a separate 
reporting database. 

Discern Analytics 
Patient Lists 

An EHR reporting feature that enables the creation of a list of patients, based upon 
demographic or clinical criteria.

Dynamic Worklist Dynamic Worklist is an individual user level reporting functionality used to identify patients 
based on many different criteria including conditions, results, orders, appointment types.

EHR Support The person or group that provides EHR technical support. This group is often responsible 
for the setup of or changes to the EHR. 

Health Maintenance 
Expectation 

A Cerner build tool used to create health maintenance actions such as scheduling dates 
or preventive screenings that display in a patient’s chart.

HealtheAnalytics HealtheAnalytics is an reporting application powered by the Cerner population health 
management platform, HealtheIntent, which collects data from multiple sources, normalizes 
the data, and leverages a single population record for every patient. HealtheAnalytics provides 
prestructured content around a specific analytic focus that includes key performance 
indicators (KPIs), reports, and data models.

HealtheLife Cerner’s name for the patient portal. HealtheLife enables patients to view their clinical 
record, access After Visit Summaries, securely message with their provider, request 
appointments, refill prescriptions, and access educational materials. 

Inclusion/Exclusion 
Criteria

Information that is used to determine whether a patient should or should not be included 
in a report, or whether a Discern Alert should be displayed for patient or not. Criteria 
include (but are not limited to) diagnosis, gender, age, lab results, medication history, and 
procedure history. 

Invitations Communication with patients generated from within the EHR using a variety of methods. 

My Favorites Reports that are set up in Discern Analytics can be saved to a list which an EHR user can 
run on demand. Each user’s list of reports is referred to as My Favorites.



20 A
P

P
E

N
D

IC
E

S
E

N
G

A
G

E
E

VA
LU

A
T

E
ID

E
N

T
IF

Y
U

S
IN

G
 T

H
E

  
E

H
R

 
U

N
M

E
T

  
N

E
E

D
A

B
O

U
T

  
T

H
IS

 G
U

ID
E

Appendix B: Dynamic Worklist
Users must have appropriate permissions to access Dynamic Worklist.

Create the Worklist
1.	 Open Dynamic Worklist from the link on the toolbar

2.	 From the List Actions dropdown menu, select Create Worklist.

3.	 Enter a name for the worklist.

4.	 Select Group/Provider or Location. 

	– If Group/Provider is selected, search and select a specific provider and relationship type, or a 
Provider Group

	– If Location is selected, a location and lookback range are required

5.	 Select Next to add criteria for the worklist. 

6.	 Select a criteria filter, for example, Age. Choose an operator from the dropdown, then select specific age 
or age range, for example, older than 65 years.

7.	 If appropriate, optionally select Care Coordinators.

8.	 To select patients who have multiple risk factors, from the Conditions category select the And operator, 
then choose appropriate risk conditions.

Note: Condition rules are specific to the health system defined by the local IT team.

9.	 From the Results options select Lab Results and select an appropriate Lookback Range. If applicable, 
multiple lab results can be Included.

Note: For multiple results the OR operation defaults. The AND operator is not selectable until all fields, 
including the Value and a Lookback Range, have been entered.

10.	From Medications search for and select appropriate medications. Use a Lookback Range that 
coordinates with Results lookback. 

11.	Optionally, select the appropriate Referral Order Status.

12.	Optionally, select Health Maintenance options.

13.	Select Summary to review the selected options, then select Finish. Select OK to complete and view 
the Worklist.
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Appendix C: Discern Analytics
Discern Analytics reports are configured by IT analysts with appropriate access. Criteria for determining 
patients who are at very high risk for another event are defined as a patient who has had 1 major ASCVD 
event, plus additional risk factors.

Creating the Queries
1.	 With appropriate credentials, launch Discern Analytics (DA2.exe). Select the Navigator tab, access the 

Domain tab, and select the appropriate domain to query. 

2.	 Right-click on the selected domain, then choose New Query.

3.	 Select the Query List tab, highlight Query1, and select Rename.

4.	 Name the query according to health system naming conventions, for example, Major ASCVD Query. 
Select OK.

5.	 From the Query List, highlight the newly named query, select Copy. 

6.	 Highlight the copied query name, then select Rename. 

7.	 Repeat steps 5-6 to create queries for each of the following risk factors, setting the Joined Query 
field to No.
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Appendix C: Discern Analytics (cont’d)

Selecting Qualifications for Each Query
The table below provides examples of the Qualifications for each query. Subsequent steps are examples of 
each query build.

Logic 
Operator

Query Qualification (Field)
Qualification 

(Type)
Section 
Logic

Formula/Values

AND
Major 

ASCVD
Problems > Problem Code Filter List OR

•	 Recent ACS
•	 History of MI
•	 History of Ischemic 

Stroke
•	 Symptomatic PAD

OR

Age Query
Person > Demographics > Age-
Years

Constant ≥ 65

Smoking Hx 
Query

(Clinical Events > Clinical Event > 
Clinical Event
Clinical Events > Clinical Event > 
Clinical Event Result)

Constant

AND

Clinical Event site name 
for “Tobacco Use”
All <appropriate> 
Valued

(Clinical Events > Clinical Event > 
Clinical Event
Clinical Events > Clinical Event > 
Clinical Event Result)

Constant

Clinical Event site name 
for “Smoking Status”
All <appropriate> 
Valued

LDL Query

Clinical Events > Clinical Event > 
Clinical Event

Constant

AND

Clinical Event name for 
LDL Test

Clinical Events > Clinical Event > 
Clinical Event Result

Constant ≥ 55

Clinical Events > Clinical Event > 
Performed Date > CD-Performed 
DT/TM

Filter List
Last 12 Months 
(for example)

Clinical Events > Clinical Event > 
Clinical Event Result Unit)

Filter List mg/dL

Statin Query

Orders > Orderable > Order Long 
Description

Filter List

AND

All applicable statins

Orders > Order Action > All > 
Action Order Status

Filter List
All applicable order 
status types (Ordered, 
In Process, Active, etc.)

Diabetes 
Query

Problems > Problem Code Filter List
All applicable Type 2 
Diabetes Mellitus codes

Hypertension 
Query

Problems > Problem Code Filter List
All applicable  
Hypertension  codes
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Appendix C: Discern Analytics (cont’d)

Selecting Qualifications – Major ASCVD Query
1.	 Select the Major ASCVD Query. From the qualification filter options, select Problems, Problem Code.

2.	 Select right-arrow to move the selection to the Qualifications section.

3.	 Select Modify Filter List.

4.	 Search for and move appropriate Problem Codes for the conditions that define Major ASCVD event 
patients to the right-hand list. 

5.	 Select Include when done.

Selecting Qualifications – Age Query
1.	 Select the Age Query. 

2.	 From the qualification filter options, select Person, Demographics, Age – Years to the 
Qualifications section

3.	 From the Qualification Type type dropdown, select Constant.

4.	 Select the ≥ operator from the list.

5.	 Enter the age parameter.

6.	 Within the Selected Columns section, add Person > Person Identifiers, Person ID.

Selecting Qualifications – Smoking History Query
1.	 Select the Smoking History Query. From the qualification filter options, select Clinical > Clinical Event.

2.	 Select Modify Filter List.

3.	 Search for, select, and move appropriate selection for Tobacco Use.

4.	 Select Include.

5.	 From the qualification filter options, select Clinical > Clinical Event Result.

6.	 Select the appropriate qualification type, for example, Constant.

7.	 In Clinical Event Result, enter or select values.

8.	 From the qualification filter options, select Clinical > Clinical Event.

9.	 Search for and move the appropriate Smoking Status option. 

10.	Select Include.

11.	From the qualification filter options, select Clinical > Clinical Event Result. 

12.	Select qualification type.

13.	In Clinical Event Result, enter or select value for desired statuses.

14.	Within the Selected Columns section, add Person > Person Identifiers, Person ID.
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Appendix C: Discern Analytics (cont’d)

Selecting Qualifications – LDL Query
1.	 Select the LDL Query. From the qualification filter options, select Clinical > Clinical Event. Choose = then 

choose the appropriate LDL test.

2.	 Select AND.

3.	 From the qualification filter options, select Clinical > Clinical Event Result.

4.	 Select operator ≥.  
Enter 70.  
Select AND.

5.	 From the qualification filter options, select Clinical > Date Performed > CE-Performed DT/TM.

6.	 Select Modify Filter List, and select desired time frame, for example, Last 12 months. Select Include.

7.	 From the qualification filter options, select Clinical > Clinical Event Result Unit.

8.	 Select Modify Filter List, and select desired time frame, for example, mg/dL.

9.	 Select Include.

10.	Within the Selected Columns section, add Person > Person Identifiers, Person ID.

Selecting Qualifications – Statins Query
1.	 Select the Statins Query. From the qualification filter options, select Orders, Orderable, Order 

Long Description.

2.	 Select Modify Filter List.

3.	 Filter or search for, move and include appropriate Statins.

4.	 From the qualification filter options, add Orders > Order Action > All > Action Order Status.

5.	 Select Modify Filter List.

6.	 Search for, select and include appropriate Action Order Statuses.

7.	 Within the Selected Columns section, add Person > Person Identifiers, Person ID.

Selecting Qualifications – Diabetes Query and Hypertension Query
Note: Steps used in this example can be used for both the Diabetes Query and the Hypertension Query.

1.	 Select the appropriate Query. From the qualification filter options, select Problems > Problem Code. 

2.	 Select Modify Filter List.

3.	 Search for and move appropriate codes for the condition. Select Include when done. 

4.	 Within the Selected Columns section, add Person > Person Identifiers, Person ID.
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Appendix C: Discern Analytics (cont’d)

Connecting the Queries
1.	 Select the Major ASCVD query tab. 

2.	 Add the Person > Person Identifiers > Person ID to the Qualifications section.

3.	 From the Qualification Type dropdown, select Subquery.

4.	 From the Formula dropdown, select In.

5.	 Choose Select Query ellipsis; select the Age Query and click OK.

6.	 Repeat steps 2-5 adding a Qualification to include a Patient ID Subquery for each additional  
risk-factor query.

Defining Columns and Settings
1.	 From the Major ASCVD query tab, select desired display columns from the options list using the Selected 

Columns move button. Column Criterion can include, but is not limited to the following: 

	– Person > Demographics > Name – Full

	– Person > Demographics > Medical 
Record Number

	– Person > Demographics > Phone

	– Person > Demographics > Email

	– Person > Demographics > Age – Years

	– Problems > Problem Code

	– Orders > Orderable > Order Catalog Long Desc

	– Orders > Order Action > All > Action 
Order Status

	– Clinical Events > Clinical Event 

	– Clinical Events > Clinical Event Result

2.	 Select the General tab.

3.	 Set Query Timeout to desired range.

Report Output
1.	 To run the report, right-click on the report name from the Domains tab, then select Run query in viewer.

2.	 To save the report, select File, Save As, and name the report appropriately.

3.	 To add the report to a specific folder, right-click on the report and select Add to Folder. Select an 
appropriate folder, then select OK.

Note: Folders can be added or modified from the report tab as applicable.

4.	 To export report data for further review and data manipulation, select Export Data from the report viewer.

5.	 Queries can be set to be personal or public. If the query is set to public other users who have access to 
the domain folder that query is stored in will have access to the query. To set a query as public:

	– Navigate to the General tab

	– Change the Visibility to Public and save the query
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Appendix D: Discern Alerts
Criteria Used in This Guide as an Example

Criteria were purposefully selected to include a broad scope of build steps for reference. 

Example criteria include one major ASCVD event plus 2 additional risk factors within specific timeframes and 
an LDL-C level that meet recommendations for treatment evaluation. 

Major ASCVD Event: Any 1 item from one of these 4 diagnosis groups defines a Major ASCVD Event5

•	 Recent Acute Coronary Syndrome (ACS) 

•	 History of MI

•	 History of Ischemic Stroke

•	 Symptomatic PAD 

VHR ASCVD Risk Factors: an ASCVD patient who also has any 2 or more of these criteria is considered very 
high risk5

•	 Age ≥ 65 years

•	 Current Smoker

•	 LDL-C ≥ 100 mg/dL persistently, despite maximally tolerated statin therapy and ezetimibe

•	 Diabetes mellitus

•	 Hypertension

2022 ACC Expert Consensus Decision Pathway Recommendations: evaluate treatment to consider addition 
of nonstatin therapies5

•	 LDL-C ≥ 55mg/dL or LDL-C < 50% reduction

•	 Currently prescribed maximally-tolerated statin therapy

Build Process Topics

•	 Create a New Rule

•	 Build the Evoke Section

•	 Build the Logic Section

	– Create the Major Event Logic

	– + Risk Factors Logic Overview 

	– Create the 2+ Risk Factors Logic

•	 Build the Actions Section

•	 Activate the Rule
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Appendix D: Discern Alerts (cont’d)

Create a New Rule

1.	 In Cerner Program Files, launch DiscernDev.exe.

2.	 Select File, New… Expert Knowledge Module.

3.	 From the Maintenance tab, enter new rule details according to the organization’s naming conventions 
and parameters:

	– Title: POST MI AT RISK PATIENTS

	– File Name: at health system discretion

	– Duration: as appropriate

	– Validation: Testing

4.	 At the bottom of the window, select the Knowledge tab to begin building the new rule.

Build the Evoke Section

1.	 In the Evoke Section of the rule, select Select Evoke Event.

2.	 Search for and select OPENCHART from the list and select OK.

Note: CLOSECHART, CLINICAL_EVENT, or other desired Evoke action may be used at the organization’s 
discretion. However, for this example, OPENCHART must be included.

3.	 From the Templates tab, Evoke subtab, select the template EKS_APPLICATION_E to add section E1. 
Links display to enable the selection of the criterion details.

4.	 Select the QUALIFIER link to display a list of options. Choose is listed in.

5.	 Select the Application link.

6.	 From the Expert Referential List Help, search for and select appropriate application(s), for example 
HNA: Powerchart.

7.	 Select the down arrow to move the selection(s) to the list.

8.	 Select Finish to commit the selection.

9.	 From the Evoke Templates, select EKS_USER_POSITION_E to create section E2.

10.	Set the QUALIFIER link to is listed in.

11.	Select the POSITION link.

12.	Highlight all applicable provider user roles. Move them to the selection list.

13.	Select Finish to commit the selection.

Build the Logic Section Overview

Steps to Build the Logic Using Nested Criteria:

•	 Set Logic to be true

•	 Nested logic to define the Major ASCVD events
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Appendix D: Discern Alerts (cont’d)

•	 Nested Logic for Risk Factors 

•	 Evaluate count for display/do not display 

Note: This guide uses nested logic loops to distinguish and count the 2 or more risk factors. Alternate 
methods may exist but are not addressed here.

Create the ASCVD Major Event Logic

Create a Nested Group for MI Diagnosis Within the Current Encounter 

1.	 From the Templates pane, Logic tab, choose EKS_LOGIC_TRUE as L1.

2.	 Open the “Palette” section.

3.	 From the Palette, choose “Grouping” and place it underneath L1, AND. 

4.	 Choose “Grouping” again to place a second set of parentheses nested within the first section.

5.	 Click the mouse inside the innermost parentheses set.

6.	 From the Templates tab, Logic subtab, select the template EKS_DIAGNOSIS_FIND_L to add section L2.

7.	 Click on OPT_DIAGOSIS.

8.	 Before searching, define Terminology by selecting the ellipsis button on the right. 

9.	 Select the appropriate types of terminology in use for the organization and then click OK. 

10.	From the OPT_DIAGNOSIS window, search for and select all terminology appropriate to use for 
Myocardial Infarction, then click OK to return to the L2 section. 

11.	In the second line of options, click the option labeled for encounter L?. Choose L1. 

12.	From Templates, choose EKS_DIAGNOSIS_DTTM_DETAIL_L as L3. Use AND logic between L2 and L3.

13.	Add detail fields to set a lookback timeframe as appropriate. 

Create a Nested Group for an MI Within any Encounter From the Last 90 Days

1.	 From the palette, add parentheses, nesting them within the existing parent parentheses. 

2.	 Change AND to OR so that either L2-L3 section or L4-L5 can be true.

3.	 In the Templates section, choose EKS_PROBLEMS_FIND_L as L4.

	– In the OPT_PROBLEM field, add the appropriate terminology for Myocardial infarction. (refer to OPT_
DIAGNOSIS above for steps) 

	– For the for person L? field, choose L1

4.	 In the Templates section, choose EKS_PROBLEMS_DATETIME_DETAIL_L as L5. 
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Appendix D: Discern Alerts (cont’d)

Create a Nested Group for Additional Major Event Problems

1.	 From the palette, add parentheses, nesting them within the existing parent parentheses. 

2.	 Change AND to OR to allow L2-L3 section or L4-L5 section or L6-L7 section to be true.

3.	 From Templates, choose EKS_PROBLEM_FIND_L as L6.

	– In the OPT_PROBLEM field, add the appropriate terminology for Recent ACS, History of Ischemic 
Stroke, and Symptomatic PAD

	– For the for person L? field, choose L6

4.	 From Templates, choose EKS_PROBLEMS_DETAIL_L as L7.

2+ Risk Factors Logic Overview

These sections use nested parentheses with “OR” functionality. Each section follows this workflow:

•	 Nest three levels of (groups) parentheses

•	 Next, within the 3rd level (innermost) parentheses, test one risk factor to determine if it applies or not

•	 Set an Append message indicating a true statement

•	 Add a logic true statement in the 2nd Level for that risk factor

•	 Verify correct logic

•	 Repeat this process for each risk factor to be included

2+ Risk Factors Logic – AGE

1.	 Within the 3rd (innermost) logic level, choose the template EKS_AGE_EVAL_L as L8 and fill in values for 
Evaluation, Age1 and Unit1, for Person L?.

2.	 While still within the 3rd logic level, choose the template EKS_BUILD_MESSAGE_L as L9, and fill in 
values for Action, MSGNAME and MSGTEXT.

3.	 From within the second-level innermost parentheses, choose template EKS_LOGIC_TRUE as L10.

4.	 Change the AND to OR to connect L8 & L9 with L10, allowing either L8-L9 or L10 to be true.

2+ Risk Factors Logic – Smoking

1.	 Within the 3rd (innermost) logic level, choose the Template EKS_CE_RESULTA_MOST_RECENT_L as 
L11, and fill in values for SMOKING STATUS, and for same encounter L?.

2.	 While still within the 3rd logic level, choose the Template EKS_BUILD_MESSAGE_L as L12, and fill in 
values for ACTION, MSGNAME, and MSGTEXT.

3.	 From within the second-level innermost parentheses, choose template EKS_LOGIC_TRUE as L13.

4.	 Change the AND to OR to connect L11 & L12 with L13, allowing either  
L11-L12 or L13 to be true.
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Appendix D: Discern Alerts (cont’d)

2+ Risk Factors Logic – LDL Results

1.	 Within the 3rd (innermost) logic level, choose the Template EKS_CE_RESULTA_MOST_RECENT_L as 
L14, and value Req LDL Cholesterol Level, and for same encounter as L?.

2.	 While still within the 3rd logic level, choose the Template EKS_BUILD_MESSAGE_L as L15, and fill in 
values for ACTION, MSGNAME, and MSGTEXT.

3.	 From within the second-level innermost parentheses, choose template EKS_LOGIC_TRUE as L16.

4.	 Change the AND to OR to connect L14 & L15 with L16, allowing either L14-L15 or L16 to be true.

2+ Risk Factors Logic – Statin Use

1.	 In the 3rd (innermost) logic level, choose the template EKS_ORDERS_FIND_L as L17, and fill in values 
for ORD_METHOD, OPT_ORDERS, OPT_QUAL, OPT_TIME_NUM, OPT_TIME_UNIT, and OPT_
ANCHOR_DT_TM.

2.	 While still within the 3rd logic level, choose the template EKS_BUILD_MESSAGE_L as L18, and fill in 
values for ACTION, MSGNAME, and MSGTEXT.

3.	 From within the second-level innermost parentheses, choose template EKS_LOGIC_TRUE as L19.

4.	 Change the AND to OR to connect L17 & L18 with L19, allowing either L17-L18 or L19 to be true.

2+ Risk Factors Logic – Diabetes Mellitus

1.	 Within the 3rd (innermost) logic level, choose the template EKS_PROBLEMS_FIND_L as L20, and fill in 
values for ORD_METHOD, OPT_ORDERS, and for person L?.

2.	 While still within the 3rd logic level, choose the template EKS_BUILD_MESSAGE_L as L21, and fill in 
values for ACTION, MSGNAME, and MSGTEXT.

3.	 From within the second-level innermost parentheses, choose template EKS_LOGIC_TRUE as L22.

4.	 Change the AND to OR to connect L20 & L21 with L22, allowing either L20-L21 or L22 to be true.

2+ Risk Factors Logic – Hypertension

1.	 Within the 3rd (innermost) logic level, choose the template EKS_PROBLEMS_FIND_L as L23, and fill in 
ORD_METHOD, OPT_ORDERS, and for person L?.

2.	 While still within the 3rd logic level, choose the template EKS_BUILD_MESSAGE_L as L24, and fill in 
values for ACTION, MSGNAME, and MSGTEXT.

3.	 From within the second-level innermost parentheses, choose template EKS_LOGIC_TRUE as L25.

4.	 Change the AND to OR to connect L23 & L24 with L25, allowing either L23-L24 or L25 to be true. 
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Appendix D: Discern Alerts (cont’d)

2+ Risk Factors Logic – Calculation

1.	 Between each major section should be the AND function to connect the risk factors sections.

2.	 Outside the parentheses, select the template EKS_CALC_SAVE_L in L26, and within Expert Editor 
EXPRESSION enter (@LOGIC:9 + @LOGIC:12 + @LOGIC:15 + @LOGIC:18 + @LOGIC:21 +  
@LOGIC:24).

Note: This statement evaluates the EKS_BUILD_MESSAGE_L templates for true (1) or not true (0), by 
adding them together.

3.	 Select OK.

4.	 Select template EKS_EVAL_L as L27. This template is needed to ensure at least 2 items (Age, LDL 
Cholesterol, etc) are true. For EXPRESSION enter @MISC26 > 1.

Build the Actions Section

1.	 Select the Action Section of the rule.

2.	 From the Templates pane, choose EKS_ALERT_FLEX_A, to add section A1.

	– Select OPT_TITLE and enter the applicable title (eg, VHR ASCVD Screening Eligibility)

	– Select TXT and enter applicable message text that utilizes both the message built with EKS_
MESSAGE_BUILD_L and the number of items that qualify (eg, “Treatment evaluation is 
recommended for this at-risk patient with VHR ASCVD. Patient has @MISC:26 risk factors, which 
are as follows: @MESSAGE:[MYMSG]”)

3.	 Choose options as desired for additional actions or information to be displayed to the provider.

	– Select OPT_ORDERS, highlight applicable orders or order sets, and select Finish

	– Select OPT_URL_BUTTON_NAME, enter applicable button name (eg, Amgen CV website)

	– Select OPT_URL_ADDRESS, enter the applicable URL hyperlink (if appropriate)

Activate the Rule
The save and enable steps ensure that the rule is placed into an active state for use in the production 
environment. Discern servers must be cycled once a rule has been created or modified.

1.	 Select the Maintenance tab.

2.	 Select the Validation dropdown and choose PRODUCTION.

3.	 Navigate to File > Save.
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Appendix E: Health Maintenance Recommendations
Health Maintenance
•	 Is accessible in the Health Maintenance section of the patient chart

•	 Forecasts due dates for VHR ASCVD risk evaluation based on necessary current diagnoses, and optional 
patient age, past and current health conditions, and treatments

•	 Due dates will automatically update when satisfied through appropriate orders or by manual update

Build Process Topics 
•	 Build Schedules

•	 Building Health Maintenance Rule Foundation

•	 Building Rules for Additional Risk Factors

•	 Building the Comprehensive Rule

Pre-Build: Start Health Maintenance Servers
1.	 Start servers 455, 456 (if using MRP), 360 (Health Expert), and 366 (Health Recommendations).

2.	 Once the new server is ready to be used by the application, set the Enable Recommendations property 
on server 366 to a value of YES or Y.

3.	 Verify that only one instance of the Health Maintenance Agents (SCP 534) server is running in 
your environment.

Note: When any changes are made to Health Maintenance cycle, the Health Maintenance Agents server 
(SCP534) and Health Expert server (SCP 360) on all nodes. 

Build Schedules
Schedules are comprised of Series, Expectations, Steps, and Satisfiers.

1.	 Schedule: To add a new schedule in the Build Tool, click New or right-click and select New Schedule.

2.	 Name the Schedule, for example, VHR ASCVD At Risk.

3.	 Select a level for the new schedule, for example, Base. Select or confirm the Type of Health Maintenance. 

4.	 Series: From the schedule tree, add a new series by right-clicking the schedule to which the new series is 
being added and select Add Series (eg, VHR ASCVD).

5.	 Expectations: From the schedule tree, right-click the applicable series to add a new expectation and 
select Add Expectation (eg, Treatment with [Medication]).

6.	 Steps: To add a new step, right-click on the applicable expectation and select Add Step. Enter 
appropriate steps for the progression of a treatment (eg, Order for [Medication] by medication class, Order 
to continue the order for medication class, revise treatment etc). Select the appropriate audience.
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Appendix E: Health Maintenance Recommendations (cont.)

7.	 Satisfiers: To add a new satisfier, right-click on the applicable step and select Add Satisfier.

8.	 Create the Satisfier Names and add appropriate detail, for example, duration and type:

Note: The satisfier type or item (order_id, event code) associated with a satisfier should never be changed. If a 
mistake has been made, inactivate the old satisfier, and build a new one.

Building Health Maintenance Rules – Overview

These steps explain the process used in this example. 

1.	 Create a New Rule to define an ASCVD patient; a patient with any 1 of the major ASCVD events.

	– Add Required Inclusion Statements to define the patient who has ASCVD

	– Assign a condition to the patient, eg, BASE_ASCVD

2.	 Create rules to define a patient with ASCVD plus other risk factors.

	– Add Required Inclusion Statements to define the patient who has ASCVD

	– Assign each a condition that reflects the base condition plus another risk factor

3.	 Create a comprehensive rule which uses these conditions to define patients with additional risk factors to 
be VHR ASCVD.

	– Assign the VHR ASCVD condition 

	– Assign the appropriate expectations to those patients

Create a New Rule

Purpose: To create a new rule to define the ASCVD population.

1.	 From HERuleBuilder.exe, select the Rule Group dropdown and select Conditions.

2.	 From the menu bar select Edit > New Rule. Enter desired rule name (eg, ASCVD BASE). 

3.	 Select the newly created rule from Rule Name task pane (eg, ASCVD BASE).

4.	 Set rule parameter Condition Operator to If at least one of the following are true.

5.	 Select OK.

Add Required Inclusion Statements 

Purpose: Defining criteria to include patients who have ASCVD. 

1.	 Select Add Sentence.

2.	 In the Sentence Selection window ensure Sentence Type - If is highlighted.

3.	 In Sentence Criteria, check Problem.



34 A
P

P
E

N
D

IC
E

S
E

N
G

A
G

E
E

VA
LU

A
T

E
ID

E
N

T
IF

Y
U

S
IN

G
 T

H
E

  
E

H
R

 
U

N
M

E
T

  
N

E
E

D
A

B
O

U
T

  
T

H
IS

 G
U

ID
E

Appendix E: Health Maintenance Recommendations (cont.)

4.	 Choose appropriate sentence(s) for the preferred criteria (SNOMED, ICD-10) for example: 
The person has an active or resolved problem with a vocabulary of <vocabulary> that equals <code>.

5.	 Select Add.

6.	 Select <vocabulary> from the sentence in the rule window.

7.	 Enter ICD-10, for example.

8.	 Select <code> from the sentence in the rule window.

9.	 In the Edit Parameter field, select ICD-10 codes, then select OK.

*See Appendix for list of appropriate codes.

10.	Repeat steps 1-9 to include additional sentences for appropriate Major Event conditions to test:

	– Recent ACS 

	– History of MI

	– History of Ischemic Stroke

	– Symptomatic PAD

Assign the Condition

Purpose: Assign a new condition to the patient who meet the criteria, which can be used in a 2nd rule to 
identify patients with additional risks.

1.	 Create a Then sentence:

	– Select Add Sentence

	– In the Sentence Selection window, ensure Sentence Type - THEN is highlighted

	– In Sentence Criteria, check Condition

	– Choose the appropriate sentence, for example: 
The person has a condition of <condition>

	– Select <condition> In the Edit Parameter window, enter a unique name for the “condition,” for 
example, BASE_ASCVD

	– Select OK

Building Rules for Additional Risk Factors

Purpose: Once the base rule is created, it can be combined with other criteria to build “combination” risk 
factors, eg, the patient has ASCVD and qualifies for the age risk factor. This guide shows one example, along 
with suggestions for additional groupings. 
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Appendix E: Health Maintenance Recommendations (cont.)

1.	 Create a New Rule.

	– From HERuleBuilder.exe, select the Rule Group dropdown and select Conditions

	– From the menu bar select Edit > New Rule

	– Enter desired rule name (eg, ASCVD + AGE) 

	– Select the newly created rule from the Rule Name task pane

	– Set rule parameter Condition Operator to If all the following are true

	– Select OK

2.	 Add Criterion for ASCVD patient.

	– Select Add Sentence

	– In the Sentence Selection window ensure Sentence Type - If is highlighted

	– Select Sentence Criteria, check Condition

	– Choose appropriate sentence, for example: 
The person has a condition of <condition>

	– Select <condition> from the sentence in the rule window

	– In the Edit Parameter window, enter the unique name for the “condition” previously defined in the 
THEN sentence, for example BASE_ASCVD 

	– Click OK

3.	 Add Criterion for Age.

	– Select Add Sentence

	– In the Sentence Selection window ensure Sentence Type - If is highlighted

	– Select Sentence Criteria, check Age

	– Choose appropriate sentence, for example: 
The person is at least <> years old 

	– Select <> from the sentence in the rule window, and set parameter to 65

4.	 Assign the Condition: (Assign a new condition to the patient who meets the criteria, which can be used 
in a 2nd rule to identify additional at-risk patients).

	– Select Add Sentence 

	– In the Sentence Selection window ensure Sentence Type - THEN is highlighted

	– In Sentence Criteria, check Condition

	– Choose appropriate sentence, for example: 
The person has a condition of <condition> 

	– Select <condition> from the sentence in the rule window. In the Edit Parameter  
window, enter a unique name for the “condition”, for example BASE_ASCVD_AGE

	– Click OK
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Appendix E: Health Maintenance Recommendations (cont.)

5.	 As desired, repeat Step 4, #1-4 to create additional risk-factor rules and conditions. The table below 
suggests some risk factor groupings. Other groupings should be considered based on the health system 
population and preferences.

Building the Comprehensive Rule
Purpose: To build a rule which tests existing rules for conditions resulting in recommendations.

1.	 Create a new rule.

	– From HERuleBuilder.exe, select the Rule Group dropdown and select Recommendation Actions

	– From the menu bar select Edit > New Rule

	– Enter desired rule name (eg, VHR ASCVD) 

	– Select newly created rule from Rule Name task pane

	– Set rule parameter Condition Operator to If at least one of the following is true

2.	 Add Sentence for conditions.

	– Select Add Sentence

	– In the Sentence Selection window ensure Sentence Type - If is highlighted

	– Select Sentence Criteria, check Condition

	– Choose appropriate sentence, for example: 
The person has a condition of <condition>

	– Select <condition> from the sentence in the rule window

	– In the Edit Parameter window, enter the unique name for the “condition” defined in the THEN sentence 
(Step 3, #5 above), for example BASE_ASCVD 

	– Click OK

Rule Name Additional Risk Factors THEN - Example condition name

ASCVD + Age ≥ 65 BASE_ASCVD_AGE

ASCVD + Diabetes Diabetes Mellitus BASE_ASCVD_DIABETES

ASCVD + Hypertension Hypertension BASE_ASCVD_HYPERTENSION

ASCVD + LDL
LDL-C ≥ 100 mg/dL persistently, despite maximally 
tolerated statin therapy and ezetimibe

BASE_ASCVD_LDL

ASCVD + Smoking Tobacco – current or historical use of smoking tobacco BASE_ASCVD_SMOKING
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Appendix E: Health Maintenance Recommendations (cont.)

3.	 Repeat #2 adding the same sentence for each newly created condition.

	– BASE_ASCVD_AGE

	– BASE_ASCVD_DIABETES

	– BASE_ASCVD_SMOKING

	– BASE_ASCVD_HYPERTENSION

	– BASE_ASCVD_STATINS

	– BASE_ASCVD_LDL

4.	 Add THEN sentences. 

	– The person has a condition of <condition> 

	– Select <condition> from the sentence in the rule window

	– In the Edit Parameter window, enter the unique name for the “condition” for example  
ASCVD_AT-RISK

	– The person qualifies for expectation <expectation>

	– Select the appropriate Expectations (previously created)

5.	 Save the rule, following health system protocols for validation and publishing.

Note: When any changes are made to Health Maintenance cycle the Health Maintenance Agents server 
(SCP534) and Health Expert server (SCP 360) on all nodes. 
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Appendix F: Patient Communications
Using Health Maintenance to Automate HealtheLife Patient Outreach 
Healthcare providers can request automated patient portal outreach for VHR ASCVD screening within 
Oracle Cerner. The patient portal outreach will be sent if the criteria are met. Additionally, providers can 
manually assign patients to an invitation list from within Dynamic Worklist.

There are multiple ways to automate patient outreach. The process outlined in this guide provides 
straightforward steps using Health Maintenance and Invitation components. Your health system or EHR 
support team may use an alternate method.

Build Process

The Build Guide is based on Health Maintenance. Invitation components are configured within Bedrock®.

•	 Building Invitation Groups

•	 Building Workflows

•	 Building Invitation Programs

Assumptions:

•	 An appropriate message template exists

•	 Invitation preferences have been defined in prefmaint.exe for all appropriate user Positions

•	 A Health Maintenance expectation has been configured

Building Invitation Groups

1.	 From the Cerner Program Files folder, launch Bedrock.exe. 

2.	 From the Design, Build, and Maintenance tab, select PowerChart and select the Health Maintenance 
Invitations wizard.

3.	 Select the Define invitation groups radio button and select Begin.

4.	 Select Add a new invitation group (or select Modify an existing invitation group if applicable) and 
select Next.

5.	 From the Define Invitation Group Details window, enter desired naming convention in the field labeled 
Invitation group name. 

6.	 Select Filter to narrow the search for the desired location. 

7.	 From the Filter Facilities window, enter the filters and select Apply Filter.

8.	 Expand the desired location hierarchy, highlight the desired location, and select the Move arrow.

Note: Only one location can be selected at a time, regardless of the location hierarchy selection.

9.	 In the field labeled Generate invitations for patients seen at this location in the last enter desired look-
back period.

10.	From the Save communication generated for patients at this location group with the following 
document type, select the appropriate storage location for communications, if applicable.

11.	Select Next.
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Appendix F: Patient Communications (cont.) 
12.	Select Browse and open desired reminder message template.

Note: Patient education materials and/or links to web content should be embedded within the message 
template as applicable.

Note: The reminder message template must be in .RTF format to be uploaded. Logos and images are not 
supported—templates should be updated accordingly prior to being uploaded.

13.	Select Next and repeat until all desired templates are uploaded.

14.	Select Finish. Create additional groups if needed.

Building Workflows

1.	 From the Health Maintenance Invitations wizard, select the Maintain workflows radio button and 
select Begin.

2.	 Select Add a new workflow and select Next.

3.	 Enter desired naming convention in the field labeled Workflow name.

4.	 From the Available Statuses pane, highlight applicable statuses (ie, Qualified, Cancel Reminder, Letter 
Sent, etc.) and select the Move arrow, and select Next.

Note: If no statuses are listed, they will need to be added using the “Add” function. Status naming 
conventions are viewable by end-users, but workflow naming conventions are not.

5.	 Define the workflow parameters as desired and select Finish when completed.

Note: The generate letter option must be checked for at least one status in order to print/send a reminder.

Building Invitation Programs

1.	 From the Health Maintenance Invitations wizard, select the Define invitations programs radio button 
and select Begin.

2.	 Select Add a new program and select Next.

3.	 Enter desired naming convention in the field labeled Invitation program name.

Note: The invitation program name displays on the patient reminder message and also to end-users.

4.	 From the Invitations Groups pane, highlight the previously defined location, and select Next.

5.	 From the Health Maintenance Expectations pane, highlight the desired expectation to be associated 
with the program, and select Next.

Note: Only one expectation can be selected at a time, and programs must be built separately. Time frames 
are dependent upon the threshold set within the Health Maintenance steps and expectations and may vary 
based on build considerations.

6.	 From the Workflows pane, highlight the desired workflow to be associated with the program.
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Appendix F: Patient Communications (cont.) 
7.	 From the Select letter type section, select the Use program specific text radio button, and select Next.

8.	 From the Program or Status pane, highlight the applicable program, select Browse.

9.	 From the dialog box, select the applicable template; choose Open.

10.	If appropriate, select Next to copy the template design to other groups.

11.	Select Finish to complete the program. Repeat the process until desired programs are created for 
all groups.

12.	To generate communication for a particular program, select Generate Communications.

13.	If specific patients are selected using the check box before selecting Generate Communications, only 
those patients will have communications generated. Selecting Generate Communications without 
selecting specific patients will print all eligible patients for the advanced filter and tab currently selected 
(including hidden patients displayed by selecting the More button). 

Note: To ensure that all patients scheduled for a letter are included in the current print-out, the advanced 
filter setting Patients with Scheduled Letter can be used.
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Appendix G: Primary Care Provider Communications
Creating an Automated Message Center Message

Primary Care Provider (PCP) Communications are used to engage and advise the identified patient’s 
Primary Care Provider. An Expert Knowledge Module (EKM) rule can be created that will automate a 
message to a particular provider’s inboxes based on a new diagnosis of Myocardial Infarction. EKM rules use 
known patient-related activities as the catalyst for actions, such as creating orders, adding clinical events, 
or sending messages. 

Build Process

Configure an EKM Rule within DiscernDev.exe with these components:

•	 Evoke statement using the addition of a new diagnosis of Myocardial Infarction, ICD-10 code I12.9, to a 
patient chart

•	 Logic statements to narrow the targeted patient population

•	 Action Groups based on Logic Statements to automate a message to the patient’s PCP and Cardiologist

Evoke Templates Used in This Guide

•	 EKS_DIAGNOSIS_E

•	 EKS_STOP_LOGIC

•	 EKS_DIAGNOSIS_INCOMING_L

•	 EKS_DIAGNOSIS_DTTM_DETAIL_L

•	 EKS_CE_RESULT_MOST_RECENT_L

•	 EKS_INBOX_A

Create the Rule and Evoke Criterion

1.	 From the Cerner Program Files folder, launch DiscernDev.exe. 

2.	 Select File, New…, Expert Knowledge Module to create a new EKM Rule.

3.	 From the Maintenance tab, enter new rule details according to the organization’s naming conventions 
and parameters. Set the status to PRODUCTION.

4.	 Select the Knowledge tab to begin building the new rule.

5.	 In the Evoke section of the rule, click Select Evoke Event.

6.	 Search for and select DIAGNOSIS_EVENT from the list and select OK.

7.	 Select the OPT_DIAGNOSIS parameter; search for and select appropriate codes, such as Acute 
Myocardial infarction.

Note: Other Evokes can be combined if it is desired to have a more complex refinement to qualify a 
particular patient population. 

8.	 Define additional parameters as appropriate.
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Appendix G: Primary Care Provider Communications (cont.)

Create Logic Statements

1.	 From the Templates pane, Logic tab, choose EKS_STOP_LOGIC, and set the parameter to STOP.

2.	 Select the template EKS_DIAGNOSIS_INCOMING_L. In the OPT_DIAGNOSIS parameter, search for and 
select Acute Myocardial Infarction, for example. Define other parameters with appropriate values, specific 
to the health system’s need and conventions.

3.	 Select the template EKS_DIAGNOSIS_DTTM_DETAIL_L. Set appropriate date and time parameters.

4.	 Add templates to further define the criteria, such recent lab values, for example, EKS_CE_RESULT_
MOST_RECENT_L.

Create Action Groups and Statements

Due to the rule’s complexity, groups of logic qualifiers are used to trigger specific Actions. Substitution values 
are used to pass encounter and patient information from the statements into the message. Adjust Logic 
Group criteria according to health system preferences and requirements.

1.	 Use parentheses to create an Action Group 1.

2.	 Build a logic statement (IF) statement to include all criteria, for example, L2 AND L3 AND L4.

3.	 Select an Action template appropriate for communication, for example, EKS_INBOX_A.

4.	 Select appropriate parameters to indicate the message type and appropriate user In-Box.

5.	 Build the message using 

	– Substitutions (@ values) to include patient-specific data and 

	– Text for the desired message content

6.	 Repeat steps 1-5 to add an Action Group that sends a message to a second provider.

Note: Discern servers must be cycled once a rule has been created or modified.



A
P

P
E

N
D

IC
E

S
E

N
G

A
G

E
E

VA
LU

A
T

E
ID

E
N

T
IF

Y
U

S
IN

G
 T

H
E

  
E

H
R

 
U

N
M

E
T

  
N

E
E

D
A

B
O

U
T

  
T

H
IS

 G
U

ID
E

Note: Please refer to the related EHR Worksheet Resource for potential codes, inclusion and exclusion criteria for your consideration.

© 2023 Amgen Inc. All rights reserved.	 USA-CCF-80435
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